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В предыдущих статьях, посвященных работе с программой Altium Designer, было рассказано 

о приемах разработки библиотек и электрических принципиальных схем (№6,7 СЭ2008). После 
создания схемы была выполнена компиляция, и теперь проект готов к разработке печатной платы, 
которую условно можно разделить на несколько самостоятельных этапов: разработка 
конструктива платы, создание правил проектирования, размещение компонентов, трассировка, 
проверка правил проектирования (DRC), отладка и подготовка технологических файлов для 
производства. В данной статье будут рассмотрены все вопросы, касающиеся первого этапа 
разработки платы, а именно, оформления конструктивных параметров. 

Под разработкой конструктивных параметров подразумевается этап разработки печатной 
платы от формирования файла платы до размещения компонентов, состоящий из четырех шагов: 
формирования контура печатной платы, описания стека слоев, установки крепежных отверстий и 
определения запрещенных зон для трассировки. Прежде чем приступить к описанным выше 
действиям, необходимо сформировать в Altium Designer новый файл печатной платы и 
разобраться с настройками, которых в редакторе плат намного больше, чем  в редакторе схем.  

Начнем с создания нового файла печатной платы, причем на данном этапе не будем 
привязывать эту плату к какому либо ранее созданному проекту, для чего выполним 
File>New>PCB. В панели Projects будет добавлен новый файл с расширением *.PcbDoc, которое 
является расширением печатной платы в программе Altium Designer. При создании файла 
*.PcbDoc он становится активным, таким образом можно сказать, что был запущен редактор 
печатных плат программы. Файлу, вновь появившемуся в панели Projects, сразу следует присвоить 
уникальное имя, для чего на нем следует нажать правой клавишей мыши (ПК) и выбрать команду 
Save. При создании новой платы редактор Altium Designer открывается в дюймовой системе 
координат, поэтому прежде разрабатывать геометрию платы необходимо установить 
пользовательские настройки. Как говорилось ранее (№5 СЭ2008) настройки редактора плат 
делятся на 2 части, настройки текущего документа и настройки всего редактора. Настройки всего 
редактора на данном этапе большого значения не имеют и будут рассмотрены в последующих 
статьях, а установка опций текущего документа производится в окне Design>Board Options. Здесь 
необходимо выбрать метрическую систему координат и установить значение шага сетки Snap Grid 
равным 2,5 мм, остальные сетки пока не критичны. 

 
ФОРМИРОВАНИЕ КОНТУРА ПЛАТЫ. Создание платы начинается с формирования ее 

контура, и данная процедура может быть выполнена несколькими действиями. Для формирования 
контура платы используется группа команд меню Design>Board Shape, из которых наиболее 
востребованными являются: 

1. Redefine Board Shape – Рисование контура платы вручную 
2. Define from Selected Objects – Формирование контура платы из выделенных объектов 
3. Define from 3D Body – Формирование контура из трехмерной модели (работает только 

в трехмерном режиме) 
4. Define Board Cutout – Формирование выреза в плате. 

Рассмотрим подробно каждый из этих инструментов на примере. Итак, для создания контура 
платы вручную, выполним команду Design>Board Shape>Redefine Board Shape, после чего курсор 
мыши переходит в режим рисования, сходный с инструментом Place Line. Теперь фиксируя левой 
кнопкой мыши (ЛК) углы контура платы можно нарисовать граничный рисунок, при этом 
комбинацией клавиш Shift+Space можно переключать режимы ортогональности для 
использования дуг и острых углов. При использовании дуги ее радиус меняется комбинациями 
клавиш Shift+”.”(точка) и Shift+”,”(запятая). Стоит отметить, что данный инструмент позволяет 
создавать только примитивные по форме контура. В режиме рисования бывает сложно 
позиционировать курсор в необходимую точку, поэтому координаты углов во время рисования 
контура можно вводить с клавиатуры. При активной команде следует нажать клавишу J, затем 
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клавишу L, после чего на экране появится окно Jump To Location, в котором предлагается ввести 
координаты. Описанная команда перемещает курсор в указанную точку, а для фиксации точки 
контура нужно после каждого ввода координат нажимать клавишу Enter. Например, чтобы создать 
контур платы в виде прямоугольника 32,5Х46 мм, следует выполнить команду Design>Board 
Shape>Redefine Board Shape, а затем, не трогая мышку, вводить последовательно координаты 
следующим образом: J>L>{100,100}>Enter>J>L>{100,132,5}>Enter>J>L>{146,132,5}>  >Enter> 
J>L>{140,100}>Enter> и закончить формирование контура нажатием ПК. 

Сразу бросается в глаза излишняя усложненность данного метода, но стоит отметить, что 
данный инструмент практически не используется. В большинстве случаев контур платы 
изначально создается в механической САПР, а потом импортируется в формате DXF или STEP. 
Рассмотрим оба эти варианта.  

Для создания контура платы воспользуемся заготовкой, заранее созданной в программе 
AutoCAD и сохраненной в формате DWG(DXF). //Файл Плата2000.DWG из папки Example с 
сайта www.soel.ru//. Для 
использования файла в формате 
DWG(DXF), находясь в редакторе 
печатных плат, выполним команду 
File>Import. В строке Тип файлов 
следует указать AutoCAD, после чего 
выбрать исходный файл с будущим 
контуром платы. На экране появится 
окно, показанное на рисунке 1, в 
котором нужно обязательно задать 
единицы измерения в группе Scale (по 
умолчанию установлены mil – в этом 
случае контур будет уменьшен в  2,54 
раза). Остальные настройки не столь 
обязательны, но рекомендуется 
указать расположение начала 
координат вставляемого рисунка в 
окне Locate AutoCAD и выбрать слои 
для импорта. При выборе слоев 
следует указывать на какой слой 
Altium Designer будет передана 
импортируемая информация. Для контура платы обычно используется графический слой 
Mechanical 1, поэтому именно он был выбран напротив исходного слоя Layer, при этом для слоя 0 
– выбрана настройка Not Imported (Не импортировать). После установки всех опций в 
соответствии с рис.1, нажимаем кнопку ОК, и в рабочей области редактора появляется 
импортированный контур. Теперь программе нужно указать, что этот контур является границами 
платы. Для этого выделяем весь импортированный контур и выполняем команду Design>Board 
Shape>Define from Selected Objects, после чего область внутри контура становится черной, а 
снаружи серой, что свидетельствует о корректном создании платы. 

Создание контура платы посредством импорта сложного контура из механических САПР в 
формате DXF (DWG) является наиболее удобным, но не обладает возможностью взаимообратного 
редактирования. Поясним, о чем идет речь. В последней версии программы имеется возможность 
в качестве платы использовать внешнюю модель в формате STEP, при этом если в исходной 
программе меняется контур платы или изменяются отверстия, то изменения автоматически 
сохраняются в начальную модель STEP и переносятся в Altium Designer. 

Рассмотрим процедуру создания ссылки на модель STEP в качестве контура платы на 
конкретном примере. В качестве заготовки воспользуемся моделью плата.STEP, из папки Example. 
Прежде чем приступить к подключению данной модели, выполним некоторые подготовительные 
действия. Во-первых, следует сделать «откат» (CTRL+Z) последних действий, чтобы убрать ранее 
созданный контур платы. Во-вторых, для использования возможности задавать ссылки на модели 
STEP надо в настройках заранее указать расположение папки с моделями, для чего откроем окно 
DXP>Preferences>PCB Editor>Models. В появившемся окне нужно нажать кнопку  и указать путь 
к расположению моделей, в нашем случае: …/example (в которой находится файл плата.step),  

Рисунок 1 – Импорт формата AutoCAD (DXF, DWG) 
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 после чего нажать 
кнопку Add. В списке 
подключенных папок с 
моделями появится новая  
ссылка, после чего нажимаем 
кнопку ОК (см. рис. 2). 

Сначала, чтобы 
использовать STEP модель 
платы ранее созданной в 
механической САПР, нужно 
переключиться в трехмерный 
режим работы. Переключения 
между двумерным и 
трехмерным режимами работы 
выполняются нажатием 
клавиш 2 и 3, при этом стоит 
помнить, что не все 
видеокарты поддерживают 
режим работы с трехмерной 
платой (для этой задачи нужна 
видеокарта с поддержкой 
DirectX9.0C и Shared Mode 
3.0). Итак, после нажатия 
клавиши 3 программа переходит в трехмерный режим работы и плата отображается синим цветом. 

Теперь нужно включить отображение STEP моделей, 
которое выполняется через панель Project (рис. 3). 
Далее можно разместить модель STEP в рабочей 
области, для чего выполним команду Place>3D Body и 
на экране появится диалог 3D Body. В появившемся 
окне выбираем тип модели Generic STEP Model и в 
нижней части нажимаем кнопку Link to Step Model. 
После предложения создать ссылку на модель 
откроется окно, в котором показана ранее заданная 
папка и все хранящиеся в ней модели. В списке 
выбираем модель плата.STEP и нажимаем кнопку ОК. 
Теперь в диалоге 3D Body нажимаем кнопку ОК и 
размещаем модель в рабочей области нажатием левой 
кнопки мыши. После размещения модели программа 
предлагает установить следующую модель, в нашем 
случае следует отказаться от этого нажатием кнопки 
Cancel. Последним шагом нужно указать, что 
добавленная модель в формате STEP является платой, 
для чего выполним команду Design>Board 
Shape>Define from 3D Body  и выполним 
последовательно два щелчка мыши на добавленной 
модели. В результате будет выдано сообщение, в 
котором предлагается задать контур платы из 
выбранной модели, с чем следует согласиться.  

Теперь мы имеем плату в трехмерном виде со 
ссылкой на модель STEP, причем эту плату можно 
вращать во всех плоскостях. Для вращения платы 
нажмите клавишу Shift, после чего на экране появится 
«шар со стрелками» (рис. 4), на котором имеются 
кнопки управления поворотом: 

1. При наведении курсора на стрелки и движение мышки с нажатой правой клавишей – будет 
осуществляться поворот в указанном стрелкой направлении 

Рисунок 2 – Подключение папки с моделями STEP 

Рисунок 3. Новый режим работы 
панели Project – работа с 3D-моделями 
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2. При наведении курсора на дуги и движение мышки с нажатой правой клавишей – будет 
осуществляться поворот в плоскости рабочей области 

3. При наведении курсора на точку и движение мышки с нажатой 
правой клавишей – будет осуществляться свободное 
вращение. 

После описанных выше действий мы имеем плату в Altium 
Designer со ссылкой на модель STEP, причем стоит обратить 
внимание, что круглые отверстия, которые были созданы в 
механической САПР, конвертировались в контактные площадки со 
свойствами обычных крепежных отверстий. Если на последующем 
этапе проектирования модель платы будет изменена в той программе, 
в которой она была создано, то в Altium Designer при обращении к 
этой модели будет выдано сообщение, показанное на рисунке 5. В 
сообщении предлагается обновить модель платы в соответствии с исходной моделью в формате 
STEP. 

Кроме инструментов по созданию контура 
печатной платы в выпадающем меню 
Design>Board Shape имеются команда для 
формирования вырезов в плате и несколько 
команд по редактированию ранее созданного 
контура платы. 

 
РАБОТА СО СЛОЯМИ. После создания 

контура платы перейдем ко второму шагу разработки конструктивных параметров платы, на 
котором определяется порядок расположения слоев печатной платы. Как известно, при разработке 
платы работа ведется с несколькими слоями, так топология проводников разрабатывается на 
одних слоях, пасты и маски наносятся в других и т.д. В программе P-CAD все слои делились на 3 

Рисунок 4 – Кнопки 
поворота платы в 

трехмерном формате 

Рисунок 5 – Сообщение об обновлении модели 

Рисунок 6 – Настройки отображения слоев 
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вида: Signal (сигнальные), Plane (экранные), NonSignal (не сигнальные). В Altium Designer похожее 
деление, за исключением того, что не сигнальные слои делятся на группы по функциональному 
назначению. Просмотр всех существующих слоев проекта и управление их отображением 
выполняется в окне View Configurations, которое вызывается командой Design>Board 
Layer&Colors или нажатием клавиши L. Если эта клавиша была нажата во время работы в 
двумерном режиме, то окно на экране будет выглядеть согласно показанному на рисунке 6. Здесь 
в правой части показаны группы слоев редактора плат:  

1. Signal Layers (Сигнальные слои) – предназначены для создания топологии проводящего 
рисунка,  

2. Internal Layers (Экранные слои) – предназначены для расположения внутренних полигонов 
земли и питании. Эти слои не предназначены для прокладки проводников и информация в 
них отображается инверсно, 

3. Mechanical Layers (Графические слои) – используются для вспомогательной графической 
информации, например, контур платы, и т.д., 

4. Mask Layers – слои паяльной пасты и защитной маски, 
5. Other Layers – дополнительные слои, к которым относятся слой зоны запрета и слои 

отображающие отверстия в плате, 
6. Silkscreen Layers – слои шелкографии, в которых располагается информация для 

маркировки на плате, 
7. System Layers (Системные слои) – правильно было бы назвать системные цвета, к которым 

относится цвет фона, сетки, соединения и др. 
В данном окне нельзя добавлять и удалять слои, здесь выполняется управление видимостью 

слоев, для чего используются кнопки в виде гиперссылок под каждой группой слоев. Например, 
для сигнальных слоев, кнопки All On, All Off, Used On (Включить все, Выключить все и Включить 
только используемые сигнальные слои). Кроме 
страницы отображения слоев в окне View Configurations 
имеются вкладки Show/Hide и View Options. На первой 
задается режим отображения примитивов (рис. 7), 
который может быть Final – полное отображение, Draft – 
отображение в виде контура, Hidden – скрыть 
примитивы. На второй вкладке (View Options) 
устанавливаются дополнительные настройки 
отображения, из которых на данном этапе стоит 
обратить внимание на опцию Origin Marker, которая включает отображение начала координат. 
Закроем окно View Configuration нажатием кнопки ОК. 

Добавление новых слоев и управление их положением в стеке печатной платы производится 
в окне, которое вызывается командой Design>Layer Stack Manager (рис. 8). В данном окне 

Рисунок 7 – Переключение режимов 
отображения примитивов 

Рисунок 8 – Управление стеком слоев 
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показана структура печатной платы, на которой видно расположение сигнальных и внутренних 
экранных слоев. В правой части окна имеется набор команд для управления порядком 
расположения слоев. Кнопки Add Layer и Add Plane добавляют сигнальный и экранный слой 
соответственно, причем в Altium Designer может быть создано 32 сигнальных и 16 экранных 
слоев. Использование экранных слоев (Plane Layer) изначально не востребовано в практике 
большинства отечественных предприятий, так как вызывает некоторые трудности в 
использовании. Во-первых, на таких слоях нельзя создавать проводники, а во-вторых, не всем 
удобно работать с инверсно отображенными слоями. Для расположения внутренних полигонов 
питания и земли используются обычные сигнальные слои, которые обладают большей гибкостью 
при работе. Кнопки Move Up и Move Down (рис. 8) перемещают выбранный слой вверх и вниз по 
списку. Для изменения свойств слоя можно выполнить двойное нажатие ЛК на его названии или 
использовать кнопку Properties. При намерении разработчика провести анализ целостности 
сигнала (команда меню Tools>Signal Integrity) необходимо корректно указать следующую 
информацию. Для сигнальных слоев: Name - задаваемое пользователем имя слоя; Copper thickness 
- толщина слоя металлизации, необходимая для анализа целостности сигналов. Для внутренних 
слоев питания и заземления: Name - задаваемое пользователем имя слоя; Copper thickness - 
толщина слоя металлизации, необходимая для анализа целостности сигналов. Для подложек и 
изолирующих слоев: Material - тип используемого материала; Thickness - толщина 
диэлектрического слоя, необходимая для анализа целостности сигналов; Dielectric constant - 
относительная диэлектрическая проницаемость материала, необходимая для анализа целостности 
сигналов. 

При формировании стека слоев конструктору необходимо определить пары слоев для 
сверления отверстий (drill-pairs). Термин drill-pairs относится к двум слоям, участвующих в 
сверлении (начальный и конечный слой). Если на плате не применяются глухие и скрытые 
переходные отверстия, то в проекте присутствует только одна пара слоев сверления, состоящая из 
верхнего и нижнего слоя. Эта пара слоев устанавливается по умолчанию и не подлежит ни 
удалению, ни модификации. 

Пары слоев сверления задаются в диалоговом окне Drill-Pair Manager, которое вызывается 
нажатием кнопки Drill-Pair в диалоговом окне Layer Stack Manager. При использовании в проекте 
глухих и скрытых переходных отверстий, пары слоев сверления должны быть определены с 
учетом используемого стиля стека слоев в строгом соответствии с требованиями представителей 
производства. 

 
КРЕПЕЖ И ЗОНЫ ЗАПРЕТА. Последние действия на подготовительном этапе разработки 

печатной платы – это установка крепежных отверстий и формирование зон запрета для 
металлизации. Крепежные отверстия устанавливаются командой Place>Pad, как обычные 
контактные площадки. После запуска команды размещения отверстий следует нажать клавишу 
Tab и в свойствах указать нулевые значения в параметрах формы контактной площадки (Size and 
Shape) и при необходимости отключить металлизацию внутри отверстия (Plated). Стоит отметить, 
что при формировании контура платы посредством импорта модели платы в формате STEP, были 
автоматически созданы отверстия, в свойствах 
которых включена металлизация и сформирован 
поясок металлизации, равный диаметру отверстия.   

Для расположения зон запрета для металлизации 
используется группа команд Place>Keepout, в которой 
имеются инструменты по формированию линий 
запрета и полигонов запрета. Исторически сложилось, 
что зоны запрета в виде линий (а так же дуг) не 
воспринимаются автотрассировщиками Specctra и 
Situs, поэтому рекомендуется их выполнять только с 
помощью команды Place>Keepout>Solid Region. Кроме 
того, что необходимо использовать только зоны 
запрета в виде полигона, нужно следить за слоем, на 
котором выполнена графика, относящаяся к Keepout 
(зоне запрета). При размещении зоны запрета, действующей на все сигнальные слои платы, 
необходимо в окне Layer выбрать слой Keep-Out layer, в противном случае в этом окне нужно 

Рисунок 9 – Свойства зоны запрета 
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выбрать конкретный слой, на который оказывает действие данная зона запрета. Так же зону 
запрета можно создать для определенной цепи, которая указывается в окне Net свойств полигона 
(рис. 9). Итак, мы рассмотрели весь комплекс мероприятий по формированию конструктивных 
особенностей печатной платы. Все описанные выше действия можно выполнить используя мастер 
создания печатных плат, в котором параметры, платы создаваемые вручную будут сгенерированы 
автоматически, путем пошагового ввода информации о плате. 

 
МАСТЕР СОЗДАНИЯ ПЕЧАТНЫХ ПЛАТ. Вернемся на начальный этап и создадим плату 

для данного проекта с помощью мастера печатных плат, для чего 
выберем команду PCB Board Wizard в панели File (рис. 10). 
Появившийся мастер PCB Board Wizard по этапам запрашивает 
информацию о печатной плате, которая потом выразится в виде 
конструктивных параметров и правил проектирования. Для 
продолжения в появившемся окне нажмем кнопку Next. В 
следующем окне будет предложено выбрать систему единиц 
измерения, в нашем случае это метрическая система мер. Нажмем 
кнопку Next. Далее будет предложен список существующих 
шаблонов стандартных промышленных печатных плат, но так как у 
нас нет шаблона, выбираем Custom (пустой бланк).  При этом 
появилось окно, в котором нужно задать форму и размеры будущей 
платы (рис. 11). В правой части данного окна задается толщина 
линий прорисовки границы платы (Boundary Track Width) и размеров (Dimension Line Width), а 
также отступ от края платы (Keepout Distance From Board Edge). 

Следующее окно предложит выбрать число сигнальных слоев, а также внутренних слоев 
питания и заземления. Наша 
плата будет иметь только два 
сигнальных слоя, поэтому в поле  
Signal Layers следует ввести 
число 2, а в поле Power Planes - 
число 0. Для продолжения 
нажмем кнопку Next. Далее 
следует определить тип 
переходных отверстий. Так как 
мы проектируем простую 
двухстороннюю плату, то 
выберем тип Thru-hole Vias 
(сквозные переходные 
отверстия). Заметим, что система 
Altium Designer позволяет 
использовать на многослойных 
платах слепые и глухие 
переходные отверстия, в том 
числе и по технологии Microvia. 
Для использования слепых и 
глухих переходов в текущем окне следует выбрать опцию Blind and Burier Vias Only. В 
следующем окне необходимо выбрать преобладающую технологию монтажа компонентов 
(поверхностный или монтаж в отверстия). При выборе опции Thru-hole components (преобладает 
монтаж в отверстия) ниже указывается допустимое число проводников между смежными 
контактными площадками. Если была выбрана опция Surface-mount components (преобладает 
поверхностный монтаж), ниже указывается разрешено или нет двустороннее размещение SMD-
компонентов. На следующем шаге от нас требуется задать минимально допустимые размеры 
объектов на печатной плате, которые будут преобразованы мастером в правила проектирования 
(рис. 12). Здесь задаются минимально допустимые: ширина проводника (Track Size), диаметр 
площадки переходного отверстия (Via Width), диаметр переходного отверстия (Via Hole Size) и 
зазор между проводниками (Clearance). Для простоты, оставим эти значения заданными по 
умолчанию. Нажмем кнопку Next. Последнее диалоговое окно сообщает, что создание заготовки 

Рисунок 10 – Запуск 
мастера создания 
печатных плат 

Рисунок 11 – Мастер создания печатных плат 
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платы завершено. Если необходимо внести какие-либо коррективы в заданные значения, то с 
помощью кнопки Back можно 
вернуться в нужное окно. В 
противном случае нажмем 
кнопку Finish. 

После описанных 
действий откроется файл 
платы созданного шаблона с 
базовым количеством 
настроек. Описанные мастер 
создания печатных плат 
удобен для быстрого создания 
плат имеющих не сложный 
контур. 

Итак, мы рассмотрели все 
варианты разработки 
конструктива платы и 
учитывая рассмотренный в 
статье предыдущего номера 
проект с электрической 
принципиальной схемой, подошли к основной стадии проектирования печатной платы. В 
следующем номере СЭ будут рассмотрены вопросы по передаче информации со схемы на плату, 
формированию классов различных объектов и разработки правил проектирования. 

Для более подробного изучения тематики статьи рекомендуется посмотреть следующие 
файлы документации Altium Designer: TR0112 PCB Editor and Object Reference.pdf, TU0132 
Integrating MCAD Objects and PCB Designs.pdf. 

Рисунок 12 – Мастер создания печатных плат 
(русифицированный интерфейс) 


